## Contents at a Glance

Getting Started ........................................ xi

### Creating and Organizing Your Photo Library

<table>
<thead>
<tr>
<th>Lesson</th>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A Quick Tour of Aperture</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>Adding and Managing Metadata</td>
<td>42</td>
</tr>
<tr>
<td>3</td>
<td>Comparing and Evaluating Images</td>
<td>102</td>
</tr>
<tr>
<td>4</td>
<td>Indexing Photos Using Faces and Places</td>
<td>148</td>
</tr>
<tr>
<td>5</td>
<td>Managing Projects and the Library</td>
<td>182</td>
</tr>
</tbody>
</table>

### Corrective and Creative Image Editing

<table>
<thead>
<tr>
<th>Lesson</th>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Performing Nondestructive Editing</td>
<td>210</td>
</tr>
<tr>
<td>7</td>
<td>Correcting Tone</td>
<td>240</td>
</tr>
<tr>
<td>8</td>
<td>Correcting Color</td>
<td>266</td>
</tr>
<tr>
<td>9</td>
<td>Making Local Adjustments with Brushes</td>
<td>294</td>
</tr>
<tr>
<td>10</td>
<td>Working with RAW Images</td>
<td>332</td>
</tr>
</tbody>
</table>

### Sharing Your Work

<table>
<thead>
<tr>
<th>Lesson</th>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Creating Dynamic Slideshows</td>
<td>358</td>
</tr>
<tr>
<td>12</td>
<td>Presenting Your Photos on the Web</td>
<td>402</td>
</tr>
<tr>
<td>13</td>
<td>Delivering Final Images as Books, Prints, and Files</td>
<td>426</td>
</tr>
</tbody>
</table>

### Appendixes

<table>
<thead>
<tr>
<th>Appendix</th>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Setting Up Your Work Environment</td>
<td>461</td>
</tr>
<tr>
<td>B</td>
<td>Expanding Aperture Functionality</td>
<td>467</td>
</tr>
</tbody>
</table>

Glossary .................................................. DVD
Index ...................................................... 471
# Table of Contents

**Getting Started** .................................................. xi

**Creating and Organizing Your Photo Library**

**Lesson 1**

A Quick Tour of Aperture ............................. 3
Opening Aperture .................................................... 4
Identifying Interface Elements ......................... 7
Importing Images from a Memory Card .................. 9
Working with Images in the Browser ................. 12
Viewing and Using Metadata ......................... 23
Adjusting Images .................................................. 26
Rating and Rejecting Images ............................ 34
Sharing Your Photos with Email ...................... 36
Sharing Photos with Facebook, Flickr, and Photo Stream ... 40
Lesson Review ........................................ 40

**Lesson 2**

Adding and Managing Metadata ...................... 43
Importing files from the Finder ........................ 44
Customizing Import Settings ......................... 45
Displaying Metadata in the Browser and Viewer .... 53
Using Keywords ............................................ 58
Editing Metadata Views and Presets ................. 80
Sorting and Filtering Your Project .................. 91
Lesson Review ........................................ 101
### Lesson 3
Comparing and Evaluating Images .......... 103
Generating Aperture Previews .................. 104
Evaluating Images in Full-Screen Mode ........ 107
Using the Loupe Tool .......................... 112
Assigning Image Ratings ....................... 118
Comparing and Rating a Group of Images ..... 120
Using Primary Selection Options to Rate Images . 123
Working with Stacks .......................... 124
Speed Rating Images Using Keystrokes .. 138
Reviewing Collections on the Light Table ... 140
Lesson Review ................................. 147

### Lesson 4
Indexing Photos Using Faces and Places ...... 149
Moving from iPhoto to Aperture .................. 150
Using Places to Put Pictures on a Map ........ 154
Creating a Smart Album from a Map .......... 170
Organizing a Library Using Faces ............... 172
Adding Facebook IDs to Faces ................... 178
Creating a Faces Smart Album .................. 179
Lesson Review ................................. 180

### Lesson 5
Managing Projects and the Library .......... 183
Importing Referenced Images ................... 184
Working with Referenced Images ............... 188
Organizing a Growing Library .................. 195
Backing Up Using a Vault ....................... 203
Lesson Review ................................... 205
Cameo: Catherine Hall .......................... 206

### Corrective and Creative Image Editing

### Lesson 6
Performing Nondestructive Editing .......... 211
Working in the Adjustments Inspector .......... 212
Fixing Underexposed and Overexposed Images ... 219
Cropping a Photo ............................. 234
Using Lift & Stamp Tools ....................... 237
Lesson Review ................................. 238
## Lesson 7
Correcting Tone ........................................ 241  
Making Adjustments in Full Screen View ................. 242  
Enhancing an Image ...................................... 243  
Improving Highlights and Shadows ....................... 248  
Adjusting Image Levels ................................... 252  
Converting Color Images to Black and White ............. 259  
Comparing Image Versions ................................ 262  
Lesson Review ............................................ 264

## Lesson 8
Correcting Color ........................................... 267  
Working with Color in the Enhance Controls ............... 268  
Controlling Image Vibrancy ................................ 272  
Selectively Improving Color Using the Color Controls . 273  
Working with Curves ...................................... 277  
Correcting Chromatic Aberration ......................... 286  
Working with an External Editor ......................... 288  
Lesson Review ............................................. 293

## Lesson 9
Making Local Adjustments with Brushes .................. 295  
Using Brushes ............................................ 296  
Adding and Erasing Brush Strokes .......................... 296  
Smoothing Skin .......................................... 298  
Brightening Areas Using the Dodge Brush ................ 302  
Darkening Areas Using the Burn Brush .................... 305  
Applying a Brush to an Entire Image ...................... 309  
Correcting Halo Artifacts ................................ 312  
Retouching Images ....................................... 313  
Cloning an Image ........................................ 321  
Making a Brush from an Adjustment ....................... 325  
Creating Multiple Instances of a Brush ................... 327  
Lesson Review ............................................. 330

## Lesson 10
Working with RAW Images ................................ 333  
Working with RAW+JPEG Pairs ........................... 334  
Comparing RAW and JPEG Files ......................... 336  
Decoding a RAW File .................................... 338  
Adjusting Boost and Hue Boost ........................... 340
Using Sharpening and Noise Reduction .................. 342
Removing Moire from RAW Images .................... 351
Saving RAW Fine-Tuning Presets ..................... 352
Working with DNG Files .............................. 353
Lesson Review ....................................... 354
Cameo: Don Holtz ................................... 355

Sharing Your Work

Lesson 11 Creating Dynamic Slideshows ............... 359
Using Slideshow Presets and Albums ................ 360
Using Slideshow Presets ............................. 360
Creating a Slideshow Album ......................... 364
Enhancing Slideshows ............................... 369
Using Titles, Transitions, and Photo Effects ........... 377
Mixing Music and Sound Effects ..................... 383
Working with Video .................................. 391
Editing to the Beat .................................... 394
Editing on the Fly .................................... 396
Sharing Your Slideshow .............................. 396
Lesson Review ....................................... 401

Lesson 12 Presenting Your Photos on the Web .......... 403
Posting to Facebook and Flickr ....................... 404
Creating a Web Journal .............................. 410
Adding Images to a Web Journal ...................... 412
Changing and Modifying Web Journal Themes ....... 414
Publishing a Web Journal ............................ 421
Using Photo Stream .................................. 422
Lesson Review ....................................... 424

Lesson 13 Delivering Final Images as Books, Prints, and Files ............... 427
Creating a Book Layout .............................. 428
Customizing Pictures and Page Layouts ............... 436
Ordering Books ....................................... 445
Delivering Printed Images ............................. 447
Printing with Presets. .................................. 449
Delivering Digital Images. .............................. 453
Lesson Review ....................................... 456
Cameo: Ron Brinkmann .............................. 458

Appendix A  Setting Up Your Work Environment  ........ 461
Adjusting Your System Preferences ...................... 462
Calibrating Your Display ................................ 462
Using Multiple Displays on a Mac ...................... 463
Using Tethered Shooting .............................. 465

Appendix B  Expanding Aperture Functionality ............ 467
Adding Plug-ins ..................................... 468
Applying Automator and Applescript ................... 468
Using Prebuilt Workflows ............................. 469
Learning to Use Automator for Aperture ............... 470

Glossary .............................................. DVD
Index .................................................. 471

See last page of this eBook for instructions on downloading your lesson files.
Welcome to the official Apple Pro Training course for Aperture, the powerful photo editing and management software from Apple. This book includes a variety of real-world photography projects, which are used as clear examples of the way Aperture works, from import and organization to image editing and output.

Whether you’re a professional photographer, someone who uses photographs in your work, or someone who is passionate about photography, this book will guide you through the Aperture nondestructive workflow from beginning to end.
The Methodology
This book takes a hands-on approach to learning Aperture. The lessons are designed to show you a real-world workflow of importing, organizing, rating, editing, exporting, printing, publishing, and archiving your images, and performing all the other tasks required after a photo shoot. The projects represent a cross-section of specialty photography genres and types of shoots. Whether or not your type of photography is specifically featured, you’ll find that the techniques taught here can be applied.

Aperture has an extensive list of keyboard shortcuts and a variety of ways to navigate through its interface and menus. We focus on the most common keyboard shortcuts you can use to increase your efficiency, and on the interface views and navigation schemes that are most effective for a typical workflow. The Aperture Help menu includes a comprehensive list of keyboard shortcuts if you want to learn more.

Course Structure
This book is designed to teach you to use Aperture using 13 project-based, step-by-step lessons and accompanying media files. It’s important to complete each lesson before going onto the next; changes that you make to files in each chapter will affect work you do in subsequent lessons. The book is divided into three sections, as follows:

Creating and Organizing Your Photo Library
Lessons 1–5 focus on creating and organizing your Aperture library. After a quick tour of Aperture, you’ll explore how to import from various sources; sort, compare, and rate images quickly and efficiently; apply keywords and metadata; search your library efficiently; utilize GPS location data; index photos based on face detection and recognition; organize images into folders and projects; and archive images in ways that are easy, secure, and intuitive.

Corrective and Creative Image Editing
Lessons 6–10 start out with the basics of image editing and move on to more advanced image-processing features of Aperture. You’ll learn to make basic adjustments—such as exposure, white balance, and cropping—and then move on to tonal correction, color correction, and local adjustments such as retouching, cloning, dodge, and burn. Finally, you’ll explore the Aperture capabilities specific to using RAW files.
Sharing Your Work
Lessons 11–13 focus on the final stage of any project: creating the final product. You’ll learn to share your images for client review in a variety of formats from prints and custom photo books to compelling web journals and dynamic slide shows that mix photos, video, and audio.

Finally, Appendix A tackles some advanced topics, such as automating and scripting workflows, tethered shooting, and multi-monitor configurations. Appendix B explores ways you can integrate third-party plug-ins for image adjustment and sharing.

System Requirements
A minimum hardware and software configuration is required to take advantage of the accelerated performance capabilities of Aperture.

Minimum requirements:

► Mac computer with an Intel Core 2 Duo, Core i3, Core i5, Core i7, or Xeon processor and 2 GB of RAM (4 GB for Mac Pro)
► OS X 10.8.2 or later
► Aperture 3.4 with the latest software updates; please note some screenshots will appear slightly different on other versions.
► iPhoto 9.3 or later

Recommended system requirements are constantly evolving as new hardware and software becomes available. To check for the latest requirements, go to www.apple.com/aperture/specs.

Before beginning to use Apple Pro Training Series: Aperture 3, you should have a working knowledge of your Mac and its operating system. Make sure that you know how to use the mouse and standard menus and commands, and also how to open, save, and close files. If you need to review these techniques, see the documentation included with your Mac.
**Copying the Aperture Lesson Files**

To follow along with all the lessons, you’ll need to copy the lesson files and libraries onto your hard disk. The lesson files and libraries are located on the DVD accompanying this book. You’ll need approximately 4 GB of free space on your hard disk.

**NOTE** If you have purchased this title as an eBook, you will find the URL to download the files on the “Where are the Lesson Files” page.

1. Insert the *APTS Aperture3* DVD into your computer’s DVD drive.
   The Finder window will open, displaying the contents of the DVD. If the window doesn’t appear, double-click the *APTS Aperture3* DVD icon to open it.

2. Drag the APTS Aperture book files folder into the Documents folder on your hard disk.

   **NOTE** The location of this folder is important. The Aperture and iPhoto libraries for this book are located in this folder. You’ll also be importing photos and referring to this folder throughout the book.

3. Once the “APTS Aperture book files” folder is copied to your Documents, eject the DVD.

4. Inside your Documents folder, double-click the recently copied “APTS Aperture book files” folder to show its contents.

5. To ensure that you are using the correct iPhoto library, double-click the APTS iPhoto library in the “APTS Aperture book files” folder.

6. If you are prompted to upgrade the Library, choose to upgrade the library.

7. If you are given the option to use iPhoto when you connect your digital camera, click the No button. If asked to Look up Photo Locations, also click No. If you receive a MobileMe has been discontinued dialog, click OK.

8. In Lesson 1, you will perform similar steps to instruct Aperture to use the APTS Aperture Library.

   **NOTE** When you complete the lessons in this book, you can return to your personal iPhoto and Aperture libraries by double-clicking the libraries located in the OS X Pictures folder, which is your personal libraries’ default location.
About the Apple Pro Training Series


Developed by experts in the field and certified by Apple, the series is used by Apple Authorized Training Centers worldwide and offers complete training in all Apple Pro products. The lessons are designed to let you learn at your own pace. Each lesson concludes with review questions and answers summarizing what you’ve learned, which can be used to help you prepare for the Apple Pro Certification Exam.

For a complete list of Apple Pro Training Series books, see the ad at the back of this book, or visit www.peachpit.com/haps.

Apple Pro Certification Program

The Apple Pro Training and Certification Programs are designed to keep you at the forefront of Apple’s digital media technology while giving you a competitive edge in today’s ever-changing job market. Whether you’re an editor, graphic designer, sound designer, special effects artist, or teacher, these training tools are meant to help you expand your skills.

Upon completing the course material in this book, you can become an Apple Certified Pro by taking the certification exam online or at an Apple Authorized Training Center (AATC). Certification is offered in Aperture, Final Cut Pro, Motion, Logic Pro, OS X and OS X Server. Certification gives you official recognition of your knowledge of Apple’s technologies and applications while allowing you to market yourself to employers and clients as a skilled user of Apple products. For those who prefer to learn in an instructor-led setting, Apple offers training courses at Apple Authorized Training Centers worldwide. These courses, which use the Apple Pro Training Series books as their curriculum, are taught by Apple Certified Trainers and balance concepts and lectures with hands-on labs and exercises. Apple Authorized Training Centers have been carefully selected and have met Apple’s highest standards in all areas, including facilities, instructors, course delivery, and infrastructure. The goal of the program is to offer Apple customers, from beginners to the most seasoned professionals, the highest-quality training experience.

For more information, please see the Apple Certification page at the back of this book, or to find an Authorized Training Center near you, go to training.apple.com.
Companion Web Page
As Aperture 3 is updated, Peachpit may choose to update lessons or post additional exercises on this book’s companion webpage, as necessary. Please check www.peachpit.com/apts.aperture3_2E for revised lessons or additional information.

Resources
Apple Pro Training Series: Aperture 3, Second Edition is not intended as a comprehensive reference manual, nor does it replace the documentation that comes with the application. For comprehensive information about program features, refer to these resources:

- The Aperture User Manual is available at support.apple.com/manuals/#aperture. You can also launch the documentation by choosing Help > Aperture Help when Aperture is launched.
Lesson Files

APTS Aperture book files > APTS iPhoto Library
APTS Aperture book files > Lessons > Lesson04

Time

This lesson takes approximately 60 minutes to complete.

Goals

Access an iPhoto library within Aperture
Merge two libraries into one Aperture library
View a photo’s location on a map
Assign a location to a photo and project
Import a GPS track log
Name detected faces in a project
Assign missing faces
Create Smart Albums of specific people
In Lesson 3, you learned that metadata can come from a camera, or can be entered manually in the form of keywords, captions, ratings, and so on. Those types of metadata are great for identifying when and how the photo was taken. But how can you precisely determine where a photo was taken or who is in the photo? You could take scrupulous notes while shooting…yeah, me neither. Thankfully, there are easy and engaging ways in which Aperture can help you.

In this lesson, you’ll examine two features that provide very natural ways to index photos—Faces and Places. Faces is a feature that not only detects faces of people in your photos, but with some minor assistance from you can also recognize those people. The second feature, Places, uses GPS data to identify where photos were taken.

Beginning with version 3.3, Aperture and iPhoto can share a photo library. When you adjust images using Aperture’s tools, the changes appear in iPhoto, and vice versa. You don’t need to import, export, or reprocess photos from one app to the other—it happens automatically. Faces and Places work across both apps, too.
Moving from iPhoto to Aperture

For many iPhoto users, switching to Aperture is a natural progression. Aperture includes almost all the fun and elegant features of iPhoto while adding more comprehensive image management, editing, and output capabilities. The unified library makes it easy to step up from iPhoto to the advanced tools in Aperture. Or return to iPhoto to create a calendar or cards after making professional edits to images in Aperture. Whether your photos are intended for professional use, or purely for fun, you get the best of both apps.

Switching Libraries

Aperture allows you to switch between different libraries without quitting the application. These could be multiple Aperture libraries that you have for different clients or separate libraries that, due to their size, need to be stored on additional storage devices. Aperture also allows you to open iPhoto libraries, beginning with iPhoto version 9.3. This is handy for keeping your personal photos separate from your client libraries, while letting you take advantage of powerful Aperture features. And even after opening an iPhoto library in Aperture, that library is still available to iPhoto. Additionally, you can open Aperture libraries in iPhoto if you want to take advantage of some iPhoto-only features. Just make sure that only Aperture or only iPhoto is open while using the other's library.

To open a different library:

1. In Aperture, select Projects in the Library inspector.
Take note that you are currently looking at the projects contained in the APTS Aperture3 Library. These projects are the ones you have been working with thus far such as the San Diego Zoo and People of NW Africa. That is about to change.

2 Choose File > Switch to Library > Other/New.

Aperture presents the Library Selector window that lists all of the libraries available to Aperture. Here you see the current library APTS Aperture3 Library and the APTS iPhoto Library that you copied from the book’s DVD during the Getting Started instructions. Below the list, you are given the opportunity to search for additional libraries or to create a new library.

3 Select the APTS iPhoto Library in the list, and then click Choose.

NOTE  Click Upgrade if prompted to upgrade the library.

Aperture switches to the APTS iPhoto Library and displays its contents. iPhoto Events are displayed in the top Projects section of the Library inspector. These new projects are skimmable to allow you to preview the projects’ images. You could now begin working with the iPhoto images with the advanced tools of Aperture. Let’s switch back to the previous Aperture library before proceeding.
4 From the File menu again, choose Switch to Library > APTS Aperture3 Library.

The Projects displayed in the Browser and the Library inspector return to the familiar elements you had been working with previously.

Switching between libraries is painless; however, you may want to gather images from multiple libraries into one. In the next exercise, you’ll create one library out of the Aperture and iPhoto libraries you used in this exercise.

**Merging Libraries**

Although switching between libraries is incredibly easy in Aperture, you may want to carry the images, metadata, and searches of one Aperture library into another. This scenario occurs when images you need for one project are split between two libraries. Here you will import an iPhoto library into the current Aperture library. However, you could have a situation where you want to merge two Aperture libraries as well. To import an iPhoto library into an Aperture library:

1 Begin in the Library inspector, selecting the Projects icon listed under the APTS Aperture3 Library.
2 Choose File > Import > Library.

Aperture automatically navigates to the expected location for the iPhoto library, which is the Pictures folder inside your user folder. For this book, you are utilizing an iPhoto library installed elsewhere.

3 In the Import dialog, select Documents in the left sidebar. Inside the Documents folder, select the APTS Aperture book files folder, and then select the APTS iPhoto Library. Click Import.

Aperture begins the merging process. A progress bar appears at the top of the interface.

When Aperture has finished the merger, the APTS Aperture3 Library updates to display its new contents. All of the Events of the iPhoto library now appear as projects in Aperture.
NOTE ▶ By default, importing images from your iPhoto library into your Aperture library copies the files. You end up with two original images: one in your Aperture library and one in your iPhoto library. This can double the amount of disk space used, so after importing your iPhoto images, you can delete your images from iPhoto, if desired.

Using Places to Put Pictures on a Map
You can now buy cameras with built-in or optional GPS capabilities. GPS-equipped cameras will record where you shot each picture, just as transparently as they capture EXIF metadata. If you own an iPhone 3G or newer, you already have a GPS-equipped camera. The built-in iPhone GPS hardware tags each photograph with location data.

The Aperture Places feature uses that GPS data to help you organize, filter, and find your images.

NOTE ▶ To use Places, you must be connected to the Internet. The Places maps and parts of the location database are not stored on your hard disk because they are updated regularly.

Viewing GPS-Tagged Images in Places
With Places, you can view all your GPS-tagged images on a map, or only those from a selected project. Let’s start by viewing all the GPS-tagged images for all your projects.
1. In the Library inspector, select Places.

![Library inspector](image1)

The viewer is replaced by a map view with a filmstrip view. You see only the images in the library that are currently tagged with location data. The red pins on the map indicate where photos were taken. You can change the style of your map to show a satellite, road, or default terrain view.

2. Click the Road button to change the Places map to a different style.

![Map view buttons](image2)

**Tip** When using a Magic Mouse or a Multi-Touch trackpad, you can zoom in to the map by swiping two fingers up or down. You can pan the map by dragging your finger.

3. Place the pointer over the red pin on the West Coast of the US.

![Map view with pin](image3)

**Note** Multiple photos taken in one general area may appear as a single pin until you zoom in to the map.

4. Click the arrow to the right of the pin's location label.
The map scales to view only those images associated with the selected pin. The filmstrip view applies the Filter HUD to filter out images that are not located in the San Francisco Bay area. You’ll need to clear that filter before you can view other images.

5 Clear the filmstrip view’s search field by clicking the Reset button (the X to the right).

You can use the Path Navigator pop-up menus at the top of the Places view to quickly jump between locations. Let’s view the pictures that were taken in Tasmania.

6 From the Path Navigator pop-up menus, choose States/Provinces > Tasmania.

   ![Map of the San Francisco Bay Area with Tasmania highlighted.]

   **Tip** If Tasmania does not appear, click the “home” icon to the left of Countries first, then try step 6 again.

Another way to zoom in to the map is to draw a selection rectangle around an area.

   **Tip** You can also zoom and pan using the map’s Overview Map pane.

7 Hold down the Command key and draw a selection rectangle around the pin to the southeast of Hobart, Tasmania. The map zooms in to the area defined by the selection rectangle.

8 In the lower right of the map, click the bottom Tasmania pin. The pin turns yellow. The two photos taken in that area are highlighted in the filmstrip view.

9 Click the arrow on the right of the Tasmania pin’s location label to zoom in.
10 Click the first image in the filmstrip view, **SJH180120108**.

The pin’s location label appears, showing which pin represents the selected image. If you are interested only in location metadata in a selected project, you can use the Places button in the toolbar.

11 In the Library inspector, select the iPhone Images project.

12 In the toolbar, click the Places button to view the Places map for this project.

Clicking the Places button in the Library inspector shows all the locations for every project. Clicking the Places button in the toolbar shows only the locations in the selected project. The functionality is the same regardless of which view you are using.

**Tip** If no pins or images appear, click the California button in the Path Navigator above the map.

**Assigning Locations**

Even without a GPS-equipped camera or iPhone, you can use Places to assign a location to a photo by dragging photos to the map.

1 In the Library inspector, select the Around San Francisco project.

2 Select the first rhino image, **IMG_2277**.
3. Shift-click the chimpanzee image to the right, **IMG_2623**, to select six images.

4. In the Places search field, type *San Francisco Zoo*. The San Francisco Zoo appears in the list.

5. In the list, choose San Francisco Zoo.

6. Click Assign Location. The selected images are now assigned to the San Francisco Zoo. Each image that you selected in the filmstrip view now has a red pin attached to it.

   You can also drop images onto the map and Aperture will attempt to find a local place of interest.

7. In the filmstrip view, select the first four images, starting with the skulls and ending with the butterfly. These images were taken at the California Academy of Sciences in Golden Gate Park.
8 On the Zoom slider, click the Zoom Out button (minus sign) four times, or until you can see Golden Gate Park at the top of the map.

9 Hold down the Command key and draw a selection rectangle around the right half of the park to zoom in to that area on the map.

10 In the map, locate the California Academy of Sciences, and then drag the four selected images onto the gray rectangle or text that marks the academy.
In the dialog that appears, click Done.

Aperture assigns those images to that map location, and also identifies the location as the California Academy of Sciences.

**Tip** If the pin displays another location, select the pin, click the Move Pins button at the bottom left of the map, and then drag the pin to a new location. Click Done after dropping the pin.

**Assigning a Location to a Project**

Although it's handy to assign individual photos to specific locations, when you have a large library of images without GPS metadata, you probably don't have the time to assign a location to each photo. A quick way to benefit from Places is to assign an entire project to a location.

1. In the Library inspector, select Projects.

2. Place your pointer over the San Diego Zoo project and click the Info button to view the Info dialog.

3. Click Assign Location to open the Location dialog.
4 In the search field, type *San Diego Zoo*.

5 In the list that appears, choose *San Diego Zoo*.
Click Assign to link all the images in the project to the San Diego Zoo location.

Close the Info dialog.

**Adding an Unknown Location to the Places Database**

When Aperture can identify your photo location, using Places is very easy; but what happens when the Aperture location database doesn’t know your location? Let’s find out.

1. In the Library inspector, select the Bhutan project, and then in the Browser, select the first image.

2. Press Command-A to select all the images.

3. In the toolbar, click the Places button.

4. Triple-click in the Places search field to select all the current text, and type Bhutan.

Not surprisingly, the list of places isn’t long, so you’ll need to add your own. When Aperture doesn’t have location information in its database, it does what we all do: it uses a search engine. You can find obscure locations and even addresses by using Assign Location.

5. Choose Metadata > Assign Location. This should look a little familiar. It’s the same Location window you saw when you clicked the Assign Location button on the project Info dialog.
6 In the search field, type *Punakha*, which is the town in Bhutan where these photos were taken.

7 Select Punakha in the Google Results.

![Google Search Results](image)

By selecting any location under the Google results, you can edit the location pin placement and the broader area associated with the location. A blue circle appears on the map that roughly identifies the area of the Punakha Dzongkhag (Fortress). Although this location is roughly where these photos were taken, the images were actually shot over a much wider area than just the fortress. Rather than be too specific, let’s modify this pin to associate it with a more general area.

8 Click the Zoom slider’s Zoom Out button three times and then drag the map up until the town of Wangdue Phodrang appears at the bottom of the map.

![Map of Bhutan](image)
9 Use the center circle and the blue arrows at the right side of the circle to highlight the map as shown.

![Map of Punakha District in Bhutan with blue circle highlighting the area.](image)

The blue circle represents the area that you will mark as the district of Punakha. Because locations can’t always be represented as a single dot, Aperture allows you to assign a wider area to a given location.

The last thing you’ll do is name this area more generally, as the town of Punakha is not only the Punakha Fortress.

10 At the bottom of the Assign Location dialog, in the Place Name field, type *Punakha District* and then press Tab.

![Assign Location dialog with Place Name set to Punakha District](image)

**Tip** You can remove any location you added to the database by choosing Metadata > Manage My Places.

11 Click Assign.

Your nine photos are now assigned to a wider area in the town of Punakha, Bhutan.
Removing a Photo from a Location

You’ve been doing well, but you just hit a small bump. You discover that The Tiger’s Nest Monastery is in Paro Bhutan, not Punakha. How did you miss that one? You’ll want to move those three photos from Punakha to the correct location of Paro.

1. Press Command-Shift-A to deselect all the images in the Browser.

2. In the Browser, select the three Tiger’s Nest images.

3. From the Action pop-up menu, choose Remove Locations to remove the red location badges from the Tiger’s Nest thumbnails in the Browser.

4. On the Zoom slider, click the Zoom Out button, and drag the map to the right until you see the town of Paro on the left side of the map.

5. Drag the three Tiger’s Nest images to the area above Paro. Click Done.

The pin and photos are assigned to Paro District. Aperture knows that this location is within the district of Paro, but that’s as much as it knows. Fortunately, it’s easy to get more specific.
6 Control-click (or right-click) the pin, and from the shortcut menu, choose New Place for Photos.

7 In the Place Name field, type Tiger’s Nest, press Tab, and click Add Place. You’ve successfully moved the 300-year-old monastery 90 miles to its correct location. Well, at least you’ve moved the three photos of the 300-year-old monastery to their correct location and added the location’s name.

**Assigning a Location in the Info Inspector**

You don’t always need to view such a large map when assigning an image location. You can do it within the Info inspector. It’s not as swanky in appearance, but it gets the job done efficiently.

1 Click the Split View button, so you can see the Viewer and the filmstrip view.

2 Select the Around San Francisco project.

3 In the filmstrip view, select the last image, IMG_3332. This photo of the famous painted ladies of San Francisco should be assigned to Alamo Square.

4 In the Inspector pane, click the Info tab.

5 In the Info inspector, click the Show Map button at the bottom of the inspector. There’s no location metadata assigned to this photo, so let’s add it.
6 In the Location field, type *Alamo Square*.

7 In the list that appears, select Alamo Square.

8 Click the Assign Location button (checkmark) to confirm the location.

The photo now has the location marked as Alamo Square in San Francisco, but it’s not as precise as you might like it. In the next exercise, you’ll move it.

**Moving a Pin**
When Aperture assigns a location for images without GPS data, it places the pin in the center of that location. Having taken the picture, you probably have a more exact knowledge of where you were. You can move a pin to match exactly where a photo was taken with just a few simple steps.

1 In the toolbar, click the Places button.

Aperture places this photo in the center of Alamo Square. The picture was actually taken at the southeast corner of the park near Steiner and Hayes Streets, so you’ll move the pin.

**Tip** If no pins appear, click the Places button in the Path Navigator to update the map.
2 On the map, click the Alamo Square pin.

3 On the Zoom slider, click the Zoom button (plus sign) three or four times.

4 In the lower left of the Maps dialog, click the Move Pins button.

![Maps dialog with Move Pins button](image)

The pin turns purple, and a dialog appears.

5 Drag the pin to the lower-right corner of Alamo Square.

![Map with_pin](image)

6 In the dialog, click Done to confirm its new location.

Being able to move a pin to the precise location where the photo was taken makes Places just as valuable for the photos in your library that lack GPS data, which is probably most of them.

**Importing GPS Track Files**

You aren’t limited to assigning locations manually or taking pictures only with your iPhone. You can get location data for your images in other ways, such as using a small handheld GPS receiver that can continuously capture location data and save it as a track log in GPX format. If you don’t want to carry a separate GPS device, certain iPhone apps do the same thing. Path Tracker is one such app that can record and save your iPhone location data as a GPS track log that you can add to Aperture.

**NOTE** Track log files include GPS receiver data. Aperture imports two track log formats: NMEA and GPX.

1 In the Library inspector, select the Around San Francisco project, if necessary.
2 In the toolbar, click the Places button, if necessary.

3 From the GPS pop-up menu below the map, choose Import GPS Track.

   ![Places button](image)

   **TIP** You could also apply location information from iPhone photos to photos in your Aperture library by choosing GPS > Import GPS from iPhone Photos.

4 Navigate to APTS Aperture book files > Lessons > Lesson04.

5 Select San Francisco GPS Track.gpx, and click the Choose Track File button to import the track log.

   With the track log imported, you can see the path that was taken during the time the photographs were shot. The track log includes timestamps that are recorded every few seconds. Because your photos have times associated with them, Aperture can match times and locations for perfect placement of each photo.

   **TIP** Make sure your camera’s date/time is correctly set. The GPS device will always get the proper time from the GPS signal but your camera requires your assistance.

   Since many of your photos in the Browser already have locations assigned, it would be easier if you could just view the images without location data.

6 Clear the Browser’s search field first, then click the Show Unplaced Images button.

   ![Browser](image)

7 In the Browser, select the first image of the cable car, **IMG_2660**.

8 Zoom in and reposition the map if necessary to focus on the lower right of the GPS track. Drag the image onto the starting point of the track log. You can find the start-
ing point by dragging the image over the track path and dropping when the label says 14 hrs 0 minutes.

9 From the dialog that appears, choose Assign Location. Each photo is placed along the track according to the time it was taken.

TIP Typically, GPS logs are created using UTC (Coordinated Universal Time, or to those of us less technical, GMT, Greenwich Mean Time). Aperture automatically assumes that track logs are UTC based and shifts the track log times based on your Mac clock settings. If your GPS device is not based on UTC time, this can cause an offset. If the track log’s timestamp is offset, you can change the time zone in the GPS menu just as you modified the time zone of the Africa images in Lesson 2.

Creating a Smart Album from a Map
Now that you have tagged all your photos with location information, you can create geography-based Smart Albums.

1 From the Library inspector, select the Places view.

2 From the Path Navigator pop-up menus, click the Home button to see the entire world map.

3 Command-drag a selection rectangle around the pins located in the western United States. This scales the map to show only that area.
4 From the Action pop-up menu at the bottom of the map, choose New Smart Album from View.

5 In the Library inspector, type Western US as the name of the new Smart Album.

6 In the toolbar, click the Places button to see a map of all the locations for images taken in the Western US if necessary.

   **TIP** If no pins appear, click the United States button in the Path Navigator above the map.

   In the future, if you add any images to your library that fall within the region defined for that Smart Album, they automatically will be added to that Smart Album. If you want to narrow your Smart Album to a specific state or city, you can use the Smart Album’s Smart Settings HUD.

7 Click the Smart Album’s Smart Settings HUD.

   The Area checkbox sets your criteria to include images that fall within the area viewed in the map.

8 Deselect the Area checkbox.

9 From the Add Rule pop-up menu, choose Place, and select the Place checkbox.
In the Place field, type *California* to narrow the geographical area for this Smart Album.

Close the Smart Album's Smart Settings HUD.

**Organizing a Library Using Faces**

Now that you know where your images were taken, you’d also like to know who is in them. Faces is an Aperture feature that not only detects human faces in images (not dogs or cats) but can also recognize the same face throughout your library.

**Using Faces View**

Like Places, Faces can be applied to an entire library or only a single project. You can choose which by using the Faces view in the Library inspector, or as in this exercise, clicking the Faces button in the toolbar.

1. In the Library inspector, select the Catherine Hall Studios project.

2. In the toolbar, click the Faces button.

   Aperture opens the Faces view, which is initially displayed as an empty corkboard with a special filmstrip view at the bottom of the window. The thumbnails are zoomed in to each face that Aperture detects in the project images. The next step is to assign names to those faces, which will add them to the corkboard area. Let’s focus on finding all the photos of the bride and groom in this wedding.

3. On the first image in the filmstrip view, click the label to ready it for text entry.

4. Type *Cathy* and press Return.
5 The next image in the Browser is selected and ready for naming; verify the image is of
the first man, and then type Ron and press Return.

TIP If you are a fan of cork, you can leave the design alone. If you desire a less
photorealistic design, you can turn off the corkboard look from the Appearance sec-
tion of Aperture preferences.

Confirming and Rejecting Matches
The corkboard is the place where any face that is detected and given a name is displayed.
Each image on the corkboard represents one or more photos that depict that person.

1 Double-click the Cathy image located on the corkboard.

Double-clicking an image on the corkboard displays the confirmed images of that
person. Images are displayed in the lower part of the window that Aperture believes
may also contain that person.

You’ll need to confirm or reject the images on the lower part of the window. Let’s zoom
in to make it easier to identify which faces Aperture thinks are similar to Cathy’s.

2 At the bottom of the window, click Faces to zoom in to the face in the photo that
Aperture thinks could be Cathy.

Not all of these images may be of Cathy, so you’ll only confirm those that are.

3 Click Confirm Faces.

4 In the bottom half of the window, click the image similar to the one shown here.

A green highlight indicates that this image will be confirmed as Cathy when you click
Done. Let’s find a faster way to confirm the remaining images.
5 Drag a selection rectangle around a few images of Cathy. Continue to click or drag to select the Cathy images.

6 Click Done. Now you can confirm the photos with the groom in them.

7 Click the All Faces button.

8 Double-click Ron.

9 Click the Faces button to zoom in, if necessary.

10 Click Confirm Faces.

11 Drag a selection rectangle around the confirmed images of Ron, leaving those images of other people out of the selection.

12 Click Done.

By confirming more images, Aperture has more angles, lighting, and facial expressions to evaluate, giving a better idea of what Ron looks like in multiple situations. After reanalyzing the remaining photos, Aperture identifies more photos that may contain Ron.

13 Click Confirm Faces.

14 Click once on the images of Ron.
15 Click twice on the images of other people to mark them as Not Ron.

![Images of Ron and Not Ron]

16 After verifying your “Ron” and “Not Ron” selections, click Done.

17 Click the All Faces button to return to the Faces view.

You could continue confirming and rejecting faces as Ron, but you get the idea. The recognition isn’t infallible, so prepare to find some misidentifications. However, Aperture can be incredibly helpful overall at quickly finding images of important people in your library.

Adding a Name to a Face
You can also use the Name button to add names to faces. In some cases, faces may be detected but—because of lighting, aging, or the way a head is tilted—the face may not be recognized as one of the people you’ve already identified. You can click the Name button to link the face with the appropriate name.

1 In the Library Inspector, select the Catherine Hall Studios project, and select the Browser view button from the toolbar.

2 Double-click the first image in the Browser, 02_0058_HJ_036-2.

3 In the toolbar, click the Name button.
4 A face label is displayed as *unnamed*. Type *Cathy* in the face label. Before you complete the name, Cathy’s ID will appear in the list.

5 From the list, choose Cathy to assign the name, then click Done.

**TIP** You can remove a face label by selecting the photo, clicking the Name button in the toolbar, and clicking the Remove button in the top-left corner of the positioning box.

**Adding Missed Faces**

On occasion, your subjects won’t be looking into the camera, so Aperture may not find their faces. Yet, you still may want to identify them in the shot. Aperture has a way for you to manually identify a face and assign a name.

1 In the toolbar, click the Browser button, or press V until the Browser is displayed.

2 Scroll the Browser until you see the image 23_0484_HJ_256.
3 Double-click the image to display it in the Viewer.

4 In the toolbar, click the Name button.

   As you can see, Aperture found Ron’s face but not Cathy’s because she is facing away from the camera. You can add Cathy so this photo shows up when you search for her.

5 In the dialog, click the Add Missing Face button.

   Drag the rectangle to position it over Cathy’s head.

6 In the face label, begin typing Cathy.

   Cathy’s name and picture are displayed.
8 From the list, choose Cathy to assign her name to the image. Click Done. This image is added to the collection of Cathy photos.

Adding Facebook IDs to Faces
If you use Facebook to share photos, you can automatically convert Faces information into Facebook tags and share with the people identified in the photos. All you need are their Facebook IDs.

1 In the Library inspector, select the Faces view.

2 On Cathy’s picture, click the Info button.

Here is where you would enter the email address associated with the recipient’s Facebook ID. You will also need to confirm that the default preference is still in place to share the Faces info. Aperture does not publish the email address on the web. The address is only used on Facebook to announce that the person has been tagged in a photo.

3 Close the Info window.
4 Choose Aperture > Preferences, and click the Export button.

5 Make sure that “Include face info in exported photos” is selected. When this option is selected, the name of the subject is added to the exported image’s metadata as a keyword.

6 Close preferences.

Creating a Faces Smart Album
After you have applied names to Faces, you can create Smart Albums based on the people in your photos.

1 In the library, select the Faces view, if necessary.

2 Shift-click Cathy and Ron's images.

3 Drag the two images to the Albums section in the Library inspector, and then press the V key to view the Browser only.
A Smart Album is automatically created with the name Cathy or Ron. But what if we wanted this Smart Album to only include photos with Cathy and Ron?

4 Click the Smart Album Smart Settings HUD.

5 In the pop-up menu at the top left of the HUD, change Any to All.

6 Close the Smart Settings HUD.

7 Click the Smart Album’s name to highlight it.

8 Double-click the word or, which is in the title of the Smart Album.

9 Change the word or to and, and then press Return.

Faces and Places information is based on emerging and constantly evolving technologies. It eventually will become essential search criteria just as keywords and EXIF metadata are today. Although Faces may make a wrong suggestion at times, and not everyone has a GPS for their camera, the flexibility of these features means any library can benefit from this technology today and reap even greater rewards as the technology matures.

Lesson Review

1. How do you switch between libraries within Aperture?
2. What command allows you to merge two Aperture libraries?
3. What is GPX?
4. How do you view a map only for photos of a certain project?
5. Where do you find the menu to create a new Smart Album based on the Places view?
6. How do you add a name to a face that has not been located by Aperture?

Answers

1. Choose File > Switch to Library. In the submenu, select Other/New to select another Aperture Library or to open an iPhoto Library. If you have previously opened the library, you will find it listed in the submenu.
2. With the destination library active within Aperture, choose File > Import > Library. You may also use this feature to merge an iPhoto library into an Aperture library.
3. GPX is one of the GPS track log file types that Aperture can import. The other supported format is NMEA.

4. Select the project, and then click the Places button in the toolbar. Selecting the Places view in the Library inspector will show you the locations for all projects.

5. The “New Smart Album from View” is found in the Places Action pop-up menu in the tool strip.

6. Select an image to display in the Viewer. In the toolbar, click the Name button, and in the dialog click the Add Missing Face button. Finally, type a name in the label.
Index

A
Actions, AppleScript, 188
Add (+) button, creating new preset, 47, 68, 362
Add Adjustment, Adjustment inspector, 213–215
Add Box button, photo boxes, 443
Add Keyword button, 63, 70
Add Missing Face button, 177–178
Add Place button, moving photo to new location, 166
Add Point button, color correction using curves, 282
Add Rule pop-up menu, RAW decode, 339
Add Subordinate Keyword button, 63
Add Text Block button, web journals, 420
Add to Favorites, projects, 198
Add Vault, backup, 203–205
Adjustment Action pop-up menu
adding adjustment, 213–214, 326
removing adjustment, 216, 246, 328–329
Adjustments
Auto Exposure, 33–34
auto-correcting white balance, 27–29
cropping images, 30–33
expanded printing options, 453
making brushes from, 296, 325–327
nondestructive, see nondestructive image editing
not using Quick Preview mode for, 106
RAW file. see RAW files
straightening, 29–30
tonal. see tonal correction
understanding fixed order of, 247–248
versions and nondestructive, 26–27
Adjustments inspector
adding adjustment, 213–215
Aperture window layout, 7
contrast adjustment, 243–244
creating effects from adjustments, 217
disabling and deleting adjustments, 216
duplicating version, 215–216
exposure. see exposure
making adjustments in Full Screen view, 242–243
making brushes from adjustments, 296, 325–327
overview of, 212–213
resetting adjustments, 217–219
sections of, 213
Adjustments tab, Inspector pane, 27–29
Adobe DNG Converter, 353
Albums
creating slideshow, 364–369
creating Smart Albums, 96–100
posting photos to Facebook, 405–407
sorting images manually into, 94–95
webpage and Smart Web Page, 410
All Faces button, 174–175
Alternate setting, multiple displays, 464
Always Show Filmstrip control, 112
Always Show Toolbar control, 112, 242, 245
Aperture, quick tour
Auto Exposure, 33–34
auto-correcting white balance, 27–29
cropping images, 30–33
importing images from memory card, 9–12
interface elements, 7–9
lesson review Q & A, 40–41
opening, 4–6
overview of, 3–4
sharing and rejecting images, 34–36
sharing photos with email, 36–40
sharing photos with Facebook, Flickr, and Photo Stream, 40
straightening images, 29–30
versions and nondestructive image adjustments, 26–27
viewing and using metadata, 23–26
working in Browser. see Browser
Aperture application icon, 4
Aperture library, 4–6, 11–12
Applescript, 188
Aspect ratio
correcting color using curves, 285
cropping slideshow images and setting, 375–377
fixed order of adjustments and, 247–248
setting crop size for printing with, 236
setting using Crop HUD, 234–235
Assign Location, Places, 158
Audio. see slideshows, adding audio
Audio Adjustments HUD, 390–391
Audio browser, slideshows, 383–389, 394–395
Auto Exposure, 33–34
Auto Levels controls, 252–254
Auto-correcting white balance, 27–29, 232–233
Autofocus Points button, 23–24
Automatic Import, Photo Stream, 423–424
Automatic source selection, repairing images, 318–321
Automatic Upload, Photo Stream, 423–424
Automator, 468–470
Auto-Stack Images HUD, 125–126
Auto-stacks, 124–126, 130

B
Background, framing images in photo box, 437–438
Backup creating on import, 187–188 personal library with Aperture 3, 5 RAW+JPEG pairs, 335
Basic view, Browser and Viewer metadata, 56
Batch Change, metadata, 65–67, 88–90
Beat, editing slideshow to the, 394–395
Black & White adjustment, 259–262, 325–330
Black & White checkbox, Photo effect, 382–383
Black points adjusting, 223–224 adjusting image luminance levels, 255–256 controlling shadows, 251–252 displaying black background to adjust, 226 Print window, 453
Black setting, multiple displays, 464
Black Tint color wheel, 269 Blur brush, 296–298
Burn brush, 305–309
Burns, Ken, 372. see also Ken Burns theme Burst mode (continuous-shooting mode), 124. see also stacks Buy Book, 445

C
Card readers, 9–12 Categories, Keywords HUD, 61–65 Centered Loupe, 112–114, 117 Chromatic Aberration adjustment, 286–288
Classic theme, changing, 369 Cloning image, Clone brush, 314, 321–325
Close Stack, 128–129 Close-up button, keywords, 71–73
Cold areas. see shadows Color adding titles to slideshow, 378–380 adjustment, 211 adjustment with Levels controls, 257–259
calibrating display, 463
converting images to black and white, 259–262
creating effects from adjustments, 217
labeling flagged images for editing, 24–25
manually navigating slideshow preset, 363–364
printing options, 449–452
Update All Vaults button, 203–204
Color channels, 220–221, 226–231, 259–262
Color clipping, 226–231, 249, 451
Color controls, 273–276
Color correction
  adjusting luminance, 277–281
  chromatic aberration, 286–288
  Color controls, 273–276
  lesson review Q & A, 293
  overview of, 267
  Saturation control, 268–269
  Tint controls, 269–271
  using curves, 281–286
  Vibrancy control, 272
  working with external editors, 288–293
Color temperatures, auto-correcting white balance, 27–29
Color value, cursor-focused Loupe, 115–116
ColorSync, 463
Column spacing, Print options, 452
Comparing and evaluating images
  assigning image ratings, 118–120
  comparing image versions, 262–264
  evaluating in Full Screen view, 107–112
  generating Aperture previews, 104–107
  lesson review Q & A, 147
  with Loupe tool, 112–117
  overview of, 103
  rating group of images, 120–122
  rating with Primary Only button, 123–124
  reviewing collections on Light Table, 140–146

speed rating using keystrokes, 138–140
  with stacks. see stacks
Contacts, 5, 85, 87
Continuous-shooting mode (burst mode), 124. see also stacks
Contrast, 244–245, 278–281
Control bar, rating images, 118–120
Control points, removing, 279
Control-T, Metadata Tooltips, 57–58
Coordinated Universal Time (UTC), GPS logs, 170
Copyright field, Import Settings, 51–52
Copyrights, 86–87, 419
Corkboard, Faces view, 172–175
Crop HUD, 31–33, 235–236, 247–248, 285
Crop tool
  correcting color using curves, 284–285
  order of adjustments, 247
  setting aspect ratio with Crop HUD, 31–33
  setting crop size for printing, 234–237
  understanding fixed order of adjustments, 247–248
Cropping images
  with Crop tool. see Crop tool
  Light Table unavailable for, 146
  modifying Ken Burns effect, 373–375
  setting slideshow aspect ratio, 375–377
Cursor-focused Loupe, 114–116
Curves
  adjusting luminance, 277–281
  color correction with, 281–286
Curves controls, 229
Customize Toolbar, 134–135

D key, control bar, 118–120
Darkening areas, Burn brush, 305–309
Date, sorting images in Browser by, 15
Decoding, RAW files, 338–340
Deleting
  adjustments, 216
  Flickr or Facebook account, 408
  keywords, 70
  keywords in Lift & Stamp HUD, 78–79
  main audio tracks, 385
  pages from book, 434–436
  predefined keywords, 61
  Retouch brush strokes, 316–317
  secondary audio tracks, 389
  vault, 204–205
  web journal pages, 414
Deleting images
  after importing, 154
  in Browser, 16–18
  customizing maps for books, 439–440
  entire album from Facebook, 405
  in Lift & Stamp HUD, 237
  from media cards on cameras, 12
  from Photo Stream, 424
  in Quick Preview, 105–106
  slideshow photos, 368
  working with RAW+JPEG pairs, 335
Demote button, stack images, 134–137
De-noise, RAW files, 345–348
Desktop & Screen Saver, System Preferences, 462
Detail slider, Skin Smoothing, 301
Detect Edges
  applying brushes to entire image, 310–311
  creating multiple instances of brush, 329
  enabling while painting, 303–305
  making brush from adjustment, 327
  using Burn brush, 307–309
Devignette, 245–246
Digital images, delivering, 453–456
Digital Negative (DNG) format, and RAW files, 353
Disk image
  importing images from memory card, 9–10
repairing broken links, 191–193
working with RAW+JPEG pairs, 334
working with referenced images, 185, 191, 193–194
Display resolution, 104
Displays setting, System Preferences, 462
DNG (Digital Negative) format, and RAW files, 353
Dock, opening Aperture from, 4
Documents folder, new library in, 200
Dodge brush, 301–305
Ducking, defined, 390–391
Duplicate Layer, 291
Duplicate Preset, printing, 450
Duplicate Project Structure, 195
Duration, slide, 370–372, 385–386, 395–396
Dynamic slideshows. see slideshows

E
Edge Detail slider, 349–350
Edge detection. see Detect Edges
Edge Sharpen, RAW files, 336–338
Edit Layout button, books, 440–445
Editing
  color labeling flagged images for, 24–25
  metadata views and presets. see metadata
  nondestructive. see nondestructive image-editing
  RAW vs. JPEG files, 336–338
  slideshows, 394–396
Effects
  adding, 214–215
  creating from adjustments, 217
  import settings, 188
Email, sharing photos via, 36–40
Empty Trash, 18
Enhance brick, 243–245
Eraser tool
  applying brushes to entire image, 310
  for brush strokes, 298
  Burn brush, 306
  correcting halo artifacts, 313
  Dodge brush, 303
  viewing painted areas as overlays, 300
EXIF (Exchangeable Image File) metadata
  creating Smart Albums using Browser filter, 98–100
    defined, 25, 43
  displaying in web journal, 418
  editing existing metadata view, 81–83
  filtering using Filter HUD, 92–94
  posted on Flickr for each photo, 410
Expanded View button, Color controls, 275
Export plug-ins, 468
Exporting
  adding Facebook IDs to faces, 179
  original digital images, 454–456
  publishing web journal, 421–422
  sharing photos via email, 37–39
  slideshows to iDevices, 397–398
  slideshows to YouTube, 399
  syncing two libraries, 201
Exposure
  adjusting, 222–223
  adjusting black point, 223–224
  adjusting brightness, 233–234
  adjusting clipped highlights, 224–226
  adjusting in Full Screen view, 243
  adjusting RAW vs. JPEG files, 337–338
  adjusting white balance with histogram, 231–233
  applying Auto Exposure, 33–34
  applying Vignette adjustment, 246–247
  displaying hot and cold areas, 222
  histograms and, 219–221
  identifying color clipping, 226–231
  resetting adjustments, 217–219
Extended desktop mode, multiple displays, 463–464
External editor, 288–293
Extracting image, from stack, 127
Extra-large book type, 428–429

F
F key, Full Screen view, 108, 310
Facebook
  adding IDs to faces, 178–179
  posting photos, 404–407
  sharing photos via, 40, 207
Face-detection capabilities, themes, 370
Faces
  adding Facebook IDs to, 178–179
  adding missing faces, 176–178
  adding name to face, 175–176
  confirming and rejecting matches, 173–175
  creating Smart Albums based on, 179–180
  defined, 149
Fade Through White transition, slideshows, 380–382
Falloff controls, Edge Sharpen, 344
Favorite projects, creating, 197–199
Feather tool
  applying brushes to entire image, 311
  with Burn brush, 306–308
  enabling edge detection, 304
  transitioning from blurred areas, 298
  viewing painted areas as overlays, 300
File Info, Import Settings, 45–46
File size, sending images with email, 39–40
File Type checkbox, Filter HUD, 339
File Types, Import Settings, 186–187
Filmstrip view, 111–112. see also Places
Filter, Browser
- creating Smart Albums, 98–100
- rating and rejecting images, 34–36
- search field, 91–92
- showing images not on Light Table, 141
- showing only flagged images, 26
- using Filter HUD, 92–94

Filter HUD
- adding four-star images to web journal, 411–412
- creating Smart Album, 96–100
- image filtering, 92–94
- updating RAW decode, 338–340

Finder
- importing files from, 9–12, 44–45
- locating referenced file in, 189
- opening Aperture from Aperture library, 5
- repairing broken reference file links in, 189–193

Fine Tuning controls, RAW files
- Boost and Hue Boost, 340–342
- decoding RAW files, 338–340
- De-noise, 345–348
- Edge Sharpen adjustment, 342–345
- Noise Reduction adjustments, 349–351
- saving presets, 352–353

Flagged images
- applying with Forward Slash key, 139
- color labeling for editing, 24–25
- creating in Browser, 21–22
- filtering Browser to show only, 26
- histograms and, 220–221

Flexible Space item, reordering images in stack, 134

Flickr
- posting photos on, 407–410
- sharing photos via, 40, 207–208

Focus on Cursor, Loupe, 115
Focus on Loupe, 116–117

Folders
- importing referenced images to, 184–188
- organizing library into, 195–196

Fonts, slideshow titles, 378–380

Format field, Naming Presets dialog, 47–48

Framing images, in photo boxes, 436–438, 444

FTP, copying exported folder to website, 422

Full Screen view, image-editing in, 7

G
- Generate Previews, 105
- Generic CMYK Profile, 448, 451
- Geotagging images, 356
- GMT (Greenwich Mean Time), GPS logs, 170
- Google Results, Places, 163
- GPS
  - importing track files, 168–170
  - setting Aperture to look up, 6
  - usefulness of geotagging images, 356
  - viewing tagged images on map in Places, 154–157
- GPX, track log format, 168–169
- Gray Tint color wheel, 269
- Gray Tint eyedropper, 270–271
- Greenwich Mean Time (GMT), GPS logs, 170
- Grid View, Browser, 15
- Grouping images, 63–65, 120–122

H
- Hall, Catherine, 206–208
- Halo Reduction brush, 312–313
- Hardware, connecting two displays to your Mac, 463
- Header image, web journal themes, 415–416
- Highlight Brightness slider, 258
- Highlight Hot & Cold Areas, 222–224, 228–229, 243
- Highlights
  - adjusting exposure, 222–223
  - adjusting luminance levels, 254–256
  - controlling, 249–250
  - correcting color casts with Tint controls, 270–271
  - dealing with detail, 224
  - displaying, 222
  - identifying color clipping, 226–231
  - limiting brushes to, 203
  - recovering clipped, 224–226
  - using contrast, 243–244
  - using Quarter-Tone Levels controls, 256–257
- Highlights & Shadow controls, 249–252
- Histogram, Adjustments inspector, 213
- Histograms
  - color correction, 278–279, 281–282, 284
  - exposure adjustments, 223
  - overview of, 219–221
  - tonal correction, 243–244, 249, 254–258
  - white balance adjustments, 231–233
- Holtz, Don, 355–356
- Horizontal axis, reading histograms, 219–221
- Hot areas. see highlights
- Hue, Color controls, 273–274, 276
- Hue Boost, RAW files, 340–342

I
- iCloud Photo Stream, 422–424
- iDevices, transferring slideshows to, 397–398
- iLife Sound Effects, for slideshows, 386–387
- Image editing plug-ins, 468
- Image Scale slider, 415, 438
- Imaging Plug-in Software Development Kit (SDK) for Aperture, 468
- Import browser, 11–12, 44–45, 51–53, 191–193
- Import Checked, Import Settings, 51, 53
- Import command, merging libraries, 153–154
- Import Settings
  - choosing location for referenced files, 185–186
creating backup on import, 187–188
excluding file types, 186–187
exploring additional, 188
importing new project, 10–12
RAW+JPEG pairs, 334–336
showing File Info on import, 45–46

Import Settings, customizing
adding descriptive metadata, 49–51
adjusting time zones, 48–49
importing images into projects, 51–53
overview of, 45
renaming images, 46–48
showing File Info on import, 45–46

Importing
GPS track files, 168–170
images from hard disk with Finder, 44–45
images from memory card, 9–12
merging libraries, 153–154
other methods for, 10
referenced images, 184–188
syncing two libraries, 202

Indexing photos
adding Facebook IDs to Faces, 178–179
creating Faces Smart Album, 179–180
creating Smart Album from map, 170–172
lesson review Q & A, 180–181
merging libraries, 152–154
organizing library using Faces, 172–178
overview of, 149
switching libraries, 150–152
using Places to put pictures on map. see Places

Info button, adding Facebook IDs to faces, 178–179
Info inspector
Aperture window layout, 7
assigning location, 166–167
changing metadata views, 23–25
creating and applying metadata presets, 86–90
displaying RAW or JPEG images, 336
editing metadata views and presets, 80–81, 83
modifying one field of metadata, 90–91
using keywords, 58–60
viewing version name in General View of, 71
Inspector HUD
adding definition, 245
applying brushes to entire image, 310–312
controlling highlights, 249
controlling shadows, 251
converting color images to black and white, 260
correcting color, 272–273
making adjustments in Full Screen view, 242–243
using brushes, 310, 317
using Hue Boost for RAW files, 341
Inspector pane, 7, 80
Intensify Contrast brush, 311
Intensity controls, Edge Sharpen, 344
Intensity slider, 246–247
Interface elements, identifying, 7–9
iPhoto, 149, 150–154
IPTC (International Press Telecommunications Council) metadata
adding descriptive metadata, 49–51
creating metadata view, 85 defined, 43, 49
editing existing metadata view, 82
exporting original digital images, 455
iTunes, slideshows for iDevices in, 397–398

K
Ken Burns theme
applying transitions to, 380–382
changing slideshow to, 369–370
modifying, 372–375
setting aspect ratio and cropping images, 375–377

Keyboard shortcuts
applying keywords, 73–77
changing for Aperture, 134
flagging images, 22
rotating images, 20
speed rating images, 138–140

Keyword metadata
adding during import, 50–51
applying with buttons, 71–73
applying with keyboard shortcuts, 73–77
applying with keyword buttons, 67–70
applying with Lift & Stamp tools, 77–80
assigning with Info Inspector, 58–60
batch changing, 65–67
defining in Keywords HUD, 60
displaying in Browser and Viewer, 54
dragging, 60–63
working with groups in Keywords HUD, 63–65
Keywords, 92–94, 97–100, 124
Keywords HUD, 60–65
Keywords library, 69–70

L
Landscape images, sorting, 14
Large book type, 429
Launchpad, opening Aperture from, 4
Layout
Aperture window, 7
book. see book layout
modifying web journal, 416–417
Layout Options inspector, photo boxes, 444–445

J
JPEG files
adjusting exposure, 222
converting to black and white, 259
generating Aperture previews, 104–107
RAW files vs., 336–338
working with RAW+JPEG pairs, 188, 334–336
Levels controls
- adjusting color, 257–259
- correcting automatically, 252–254
- luminance, 254–256
- Quarter-Tone, 256–257

Libraries
- creating and viewing, 11
- merging, 152–154
- organizing projects in. see projects
- organizing using Faces. see Faces
- reprocessing all RAW files in, 339–340
- switching between different, 150–152

Library inspector
- Aperture window layout, 7–9
- creating and storing Light Table in, 140–142
- creating favorite projects, 197–199
- Faces, using. see Faces
- putting pictures on map. see Places
- switching between different libraries, 150–152

Library Selector window, 151

Lift & Stamp HUD, 78–80, 237

Lift & Stamp tools, 77–80, 237–239

Light Table, 140–146
- Light Table Navigator button, 144–146

Links, repairing broken reference file, 189–193

List View, Browser, 15

Local adjustments, 211. see also brushes

Locate Reference Files command, 192

Location. see Places

Log files, importing GPS track, 168–170

Login
- Facebook, 404
- ordering books, 446
- posting photos to Flickr, 408

Loupe tool
- Centered Loupe, 112–114
- cursor-focused, 114–116
- defined, 112

Magnification, with Loupe tool, 28–29

Mail, sending images with email, 36–40

Managed libraries
- converting managed files into reference files, 195
- converting referenced images to, 194–195
- overview of, 184
- syncing two libraries, 201
- using multiple libraries, 199–200

Map Options HUD, 441–442

Maps
- customizing for books, 439–441
- putting pictures on. see Places
- viewing photos on, 6

Master images, 26–27

Master pages, books
- changing, 430–432
- changing images in photo box, 442
- deleting and rearranging, 435–436

McCurry, Steve, 206

Medium book type, 429

Memory cards
- choosing location for referenced files, 184–186
- erasing, 12

excluding file types on import, 186–187
- handling RAW+JPEG pairs, 334–336
- importing images from, 9–12

Merging
- keywords, 64–65
- libraries, 152–154
- stacks, 131

Metadata
- creating and applying presets, 86–90
- creating metadata view, 83–86
- creating Smart Albums, 96–97
- creating Smart Albums using Browser filter, 98–100
- customizing Import Settings.
  see Import Settings, customizing
- defined, 14
- displaying in Browser and Viewer, 53–58
- displaying in web journal, 417–418
- editing existing metadata view, 80–83
- exporting original digital images, 455
- filtering data in Browser, 91–92
- filtering data using Filter HUD, 92–94
- importing files from Finder, 44–45
- lesson review Q & A, 101
- modifying one field, 90–91
- populating webpages automatically, 413–414
- selecting and rotating images, 19
- sorting images into albums, 94–95
- using keywords. see keyword metadata
- viewing and using, 23–26

Metadata Presets controls, Import Settings, 49–51, 52

Metadata Views dialog, 81–86

Midtones
- adjusting luminance curves, 278–280
- adjusting luminance levels, 256
correcting color casts with Tint controls, 270–271
limiting brushes to, 303
using Quarter-Tone Levels controls, 256–257
Mirror setting, multiple displays, 464
Moire slider, removing moire from RAW files, 351–352
More Options button, Print window, 452–453
Mouse
panning images in Viewer with scrolling, 109
resizing images in Light Table, 142–146
using cursor-focused Loupe with, 114–116
Move Pins button, Places, 160, 168
Movies category, iTunes, 397–398
Multiple displays, 463–464
Multiple libraries, 199–200
Music
adding main audio track to slideshow, 383–385
adjusting audio levels, 390–391
editing slideshows on the fly, 396
editing slideshows to the beat, 394–395
fitting slideshow and music durations, 385–386

Name button, Faces, 175–178
Naming
custom keyword preset group, 69
new project, 11
presets, 46–48
Smart Albums, 97, 99, 171
web journals, 410–411
Naming images
for easy identification and access, 10
in Faces, 172–173, 175–178
importing files from Finder, 45
modifying one field of metadata, 90–91
slideshow album, 365
Naming location, Places, 164
Navigation
images in Light Table, 144–146
Manual preset for slideshow, 361–364
Navigation box, Full Screen view, 110
Noise reduction, for RAW images with De-noise adjustment, 345–348
with Noise Reduction controls, 349–351
removing moire, 351–352
Nondestructive image-editing in Adjustments inspector, see Adjustments inspector
copping photo, 234–237
lesson review Q & A, 238–239
tools for, 211–212
for underexposed and overexposed images, 219–234
using Lift & Stamp tools, 237–238
versions and, 26–27
Path Navigator pop-up menus, Places, 167, 170–172
Perceptual colorimetric rendering, Print window, 452–453
Photo book plug-ins, 468
Photo boxes
arranging new, 443–445
changing images in, 441–442
changing master pages, 430–432
customizing maps for books, 440–442
dragging images for book pages to, 432–433
framing images in, 436–438
Photo Descriptors button, 68–70, 71–73
Photo effects, adding to slideshow, 382–383
Photo Essay theme, 430, 440–441
Photo Stream
sharing photos via, 40
using, 422–424
Photos
sharing via email, 36–40
sharing via Facebook, Flickr, and Photo Stream, 40
Photo-sharing sites
posting on Facebook, 404–407
posting on Flickr, 407–410
sharing photos via, 40, 207–208
Pick button, reordering images in stack, 134–135
Pick image, 131–137
Pictures folder, 185–186
Pins, see Places
Pixel Grid, cursor-focused Loupe, 116
Pixels
cloning image, 314, 321–325
viewing in histogram, 219–221
Place Order, for books, 447
Places
adding unknown location to database, 162–164
assigning location in Info inspector, 166–167
assigning location to project, 160–162
assigning locations, 157–160
creating Smart Album from map, 170–172
importing GPS track files, 168–170
moving pin, 167–168
overview of, 154
removing photo from location, 165–166
viewing GPS-tagged images, 154–157

Play Slideshow button, 366
Plug-ins, adding, 468
Polarize filter, 311
Portrait images, sorting, 14
Prebuilt workflows, 469
Preferences
location for Aperture library, 11
opening Aperture for first time, 6
Photo Stream, 423
preview, 104–105
sharing photos with email, 36–37
work environment with system, 462
Presets
adjustment, 188
custom keyword, 68–70
descriptive metadata, 49–51
Edge Sharpen, 345
edited quality settings for web journal publishing, 421–422
Effects, 214–215
email export, 37–39
Fine Tuning Adjustment for RAW files, 352–353
metadata, 86–90
printing with, 449–451
renaming images, 46–48
slideshow, 360–364
Preview Book button, 446
Preview Quality slider, 104–105
Preview Slideshow button, 367
Previews
expanded printing options, 453
generating Aperture, 104–106
using Quick Preview mode, 106–107

Printed images
delivering, 447
expanded options for, 452–453
printing with presets, 449–451
proofing onscreen, 447–449

Printing
determining costs of book, 429
expanded options for, 452–453
ordering books for, 445–446
with presets, 449–451
setting crop size, 235–237
Privacy level, posting photos to Facebook, 405

Projects
assigning location to, 160–162
back up using Vault, 203–205
creating favorites, 197–199
defining Aperture, 10
importing new, 10–11
importing referenced images, 184–188
lesson review Q & A, 205
moving images between, 196–197
overview of, 183
syncing two libraries, 200–202
using folders, 195–196
using multiple libraries, 199–200
using referenced images, 188–195
Promote button, reordering images in stack, 134–137
Proofing, printed images onscreen, 447–449
Proofing Profile, 448
Publishing
photos to Facebook, 405
photos to Flickr, 408–409
web journal, 421–422

RAW files
adjusting Boost and Hue
Boost, 340–342
adjusting exposure, 222
adjusting white balance in, 29
applying edge sharpening, 343–345
comparing JPEG files to, 336–338
correcting to black and white, 259
decoding, 338–340
defined, 334
defining edge sharpening, 345–348
generating Aperture previews, 104–107
import settings for JPEG paired with, 188
lesson review Q & A, 354
overview of, 333
removing moire from, 351–352
saving fine-tuning presets, 352–353
using Noise Reduction adjustments, 349–351

Quantization, 281–286
Quarter-Tone controls, Levels adjustment, 256–257
Quick Brush pop-up menu, 296, 324–325 see also brushes
Quick Preview mode, 106–107
QuickTime, uploading slideshows to YouTube, 399–400

R
Radius slider
Noise Reduction controls, 349–350
removing moire from RAW images, 351–352
Skin Smoothing, 300–301
Vignette adjustment, 246–247
Range
adjusting luminance curves, 279–280
changing single color with Color controls, 274
expanding Color controls, 276
Rating images
with control bar, 118–120
creating slideshow album, 364
creating web journal, 412
in Full Screen view, 109–110
in groups, 120–122
with keyboard shortcuts, 34–36
with Primary Only button, 123–124
using keystrokes for speed, 138–140
working with DNG files, 353
working with RAW+JPEG pairs, 334–336
Recovery slider, highlights, 224–226, 249–250
Red eye correction, not for images in Light Table, 146
Referenced images
converting to managed images, 194–195
finding original files, 189
importing, 184–188
moving, 193–194
repairing broken links, 189–193
syncing two libraries, 201
Registration form, opening Aperture for first time, 5
Reject rating, images, 34–36, 119
Relative colorimetric rendering, Print window, 452
Relinking broken links, 189–193
Relocate Originals, 192–193, 195
Remove from Favorites, 198
Remove Locations, Places, 165
Remove Pages (–) button, books, 436
Remove this adjustment, 216
Remove Vault, 204
Rename Files, Import Settings, 46–48, 52, 186
Rendering section, Print options, 452–453
Reordering images, web journal layout, 416–417
Repair brush, 314–316, 322–323
Reprocess Photos, updating RAW decode, 339–340
Reset button
adjustments, 217–219
Browser search field, 92
Filter HUD, 94
Keywords HUD, 63
Resize handles, 32–33, 142, 235
Resolution
choosing external editor, 290
evaluating images in Full Screen view, 107–110
generating Aperture previews, 104–107
setting crop size for printing, 235
slideshow previews and, 367
using Quick Previews, 106–107
Retouch tool
cloning image, 321–325
deleting brush strokes, 316–318
overview of, 313–314
repairing images, 315–316, 318–321
RGB, 257–259, 281–286
Rotating images, in Browser, 19–20
Rotation tool, 19–20
Rule-of-thirds guides
correcting color using curves, 285
Crop HUD, 32–33
setting crop size for printing, 236

S
Safari, posting photos on Facebook, 406–407
Saturation
adjusting color for, 268–269
Black & White adjustment vs., 259
boosting or reducing with vibrancy, 272
changing single color with Color controls, 274
expanding Color controls, 276
Scale to Fit button, Shift-A, 145
Scale To Fit Centered, framing images in photo box, 437
Scrolling mouse, panning images in Viewer, 109
Search criteria, Filter HUD, 92–94, 97
Search field, Browser, 91–92, 98–100
Search field, Places, 162–164
Secondary audio tracks, 388, 391
Secondary viewer, multiple displays, 464
Select button, rating images, 120
Select Targeted Image, Loupe, 117
Selected Slides, increasing duration of multiple slides, 371–372
Selecting images, in Browser, 19–20
Set Master Page menu, book layout, 431–432
Set Photo Filter pop-up menu, 445
Shadows
adjusting black point, 223–224
adjusting exposure, 222–223
adjusting luminance curves, 278–280
adjusting luminance levels, 254–256
brightening using Dodge brush, 301–305
controlling, 251–252
correcting color casts with Tint controls, 270–271
darkening using Burn brush, 305–309
dealing with detail, 224
displaying, 222
identifying color clipping, 227–228
limiting brushes to, 303
using contrast, 243–244
using Quarter-Tone Levels controls, 256–257
Sharing photos
as books. see books
delivering digital images, 453–456
delivering printed images. see printed images
lesson review Q & A, 424–425
overview of, 403
posting to Facebook, 40, 404–407
posting to Flickr, 40, 407–410
using Photo Stream, 40, 422–424
using web journal. see web journals
via email, 36–40
via slideshows, 396–400
Sharpening
De-noise adjustment for, 345–348
with Edge Sharpen adjustment, 342–345
Noise Reduction adjustments for, 349–351
Ship Via pop-up menu, ordering books, 447
Show Map button, Info inspector, 166–167
Show Multiple, Viewer Mode, 137
Show Unplaced Images button
adding images to web journal, 413
changing images in photo box, 442
importing GPS track files, 169–170
Light Table, 141
Show Vaults button, 204
Show Viewer button, 368–369
Skin Smoothing brush, 298–301
Slideshows
applying transitions, 380–382
changing slide duration, 370–372
changing themes, 369–370
creating with slideshow album, 364–369
creating with slideshow presets, 360–364
editing on the fly, 396
editing to the beat, 394–395
lesson review Q & A, 401
modifying Ken Burns effect, 372–375
setting aspect ratio and cropping images, 375–377
sharing, 396–400
using photo effects, 382–383
using titles, 377–380
working with video, 391–394
Slideshows, adding audio
adding main audio track, 383–385
adjusting audio levels, 390–391
fitting music durations with, 385–386
inserting iLife sound effects, 386–389
mixing music and sound effects, 383
Small book type, 429
Smart Albums
adding images to Light Table from, 140–142
creating, 96–97
creating Faces, 179–180
creating from map in Places, 170–172
creating with Browser filter, 98–100
overview of, 96
Smart Settings HUD, Smart Album, 171–172, 180
Snapshots, Slideshow Preset, 361
Social networks, sharing photos via, 40, 207
Softening, photo, 342
Sorting images. see also filter,
Browser into albums, 94–95
auto-flowing pictures to book pages, 434
in Browser, 14–15
creating Smart Albums, 96–100
using slideshow presets, 360–361
Sound effects
adding to slideshow, 386–389
adjusting audio levels, 390–391
Span setting, multiple displays, 464
Speed field, slideshow transitions, 381
Speed rating of images, 138–140
Split Stack, 130
Split View
assigning location in Info inspector, 166–167
auto-correcting white balance, 27–29
Browser and Viewer metadata, 54–58
keyword buttons, 67–70
printing with presets, 450
Quick Previews, 106
rating and rejecting images, 35
RAW+ JPEG pairs, 336
Stack mode, 132–133
Spot & Patch control, 314
Stack mode, 131–137
Stacks
adding images to web journal, 413
creating manually, 129
extracting and adding images to, 126–129
merging, 131
not required to use compare feature, 262–264
overview of, 124
promoting and demoting picks, 133–137
splitting, 130
using auto-stack, 124–126
using Stack mode, 131–133
Stamp tool, applying keywords with, 78–80
Star ratings. see rating images
Storage space, RAW vs. JPEG files, 334, 336
Store Files pop-up menu, referenced files, 185
Straightening images, 29–30, 146
Switch Aspect Ratio button, 236, 285
Switching between libraries
creating backup on import, 187–188
overview of, 150–152
syncing two libraries, 202
using multiple libraries, 200
Synchronization
Facebook album with update album, 406
transferring slideshows to iDevices, 398
of two libraries, 200–202
System Preferences, work environment, 462–464

T
Temperature parameter, white balance, 232–233
Tethered shooting, work environment, 465
Text, adding to web journal, 419–421
Themes
book, 428–430
slideshow, 363, 365, 369–370, 384–385
slideshow video clips, 392–393
web journal, 411, 414–417
Third-party plug-ins, adding, 468
Thumbnail Image Preset pop-up menu, web journal, 421–422
Thumbnail Resize slider, 126
Time Zone controls, Import Settings, 48–49, 52
Timestamp metadata
  auto-stack images with, 124–126
  importing GPS track files, 169
Tint controls, 269–271
Tint parameter, adjusting white balance, 232–233
Titles, slideshow, 377–380
Tonal correction
  adding definition, 244–245
  adding vignette, 246–247
  adjusting image levels automatically, 242–254
  adjusting in Full Screen view, 242–243
  controlling highlights, 249–250
  controlling shadows, 251–252
  converting color image to black and white, 259–264
  lesson review Q & A, 264–265
  ordering of adjustments, 247–248
  overview of, 241
  removing camera vignetting, 245–246
  using contrast, 243–244
Tone, viewing in histogram, 219–221
Tool strip, 7. see also adjustments
Toolbar
  Aperture window layout, 7
  customizing to reorder images in stack, 134
  in Full Screen view, 242
  restoring default, 135
  switching projects in Full Screen view, 112
Track logs, importing GPS files, 168–170
Transitions, slideshow, 380–382
Trash, Library Inspector, 17–18
Trim video clips, slideshows, 393–394
Updates, RAW decode, 338–340
UTC (Coordinated Universal Time), GPS logs, 170

V
Vault, backup using, 203–205
Versions, image
  comparing, 262–263
  creating original, without adjustments, 216
  creating when opening external editor, 292
  disabling and deleting adjustments, 216
  displaying version names, 57
  duplicating, 215–216
  nondestructive adjustments and, 26–27
  renaming images, 46–48
  setting crop size for printing, 235–237
  viewing version names, 71
Vertical axis, histograms, 219–221
Vibrancy, image, 272
Video, slideshow, 391–394
Viewer
  Aperture window layout, 7
  in Full Screen view, 242–243
  metadata in, 53–58
  panning images with scrolling mouse, 109
  playing slideshow for quick playback, 367
  proofing onscreen, 448
  results of photo effects shown only in, 383
  sorting images, 13–14
  Stack mode, 132–133
Vignettes
  applying Vignette adjustment, 246–247
  fixed order of adjustments, 248
  removing camera, 245–246
Volume, editing slideshows to the beat, 395

Web journals
  adding images, 412–414
  adding text, 419–421
  changing themes, 414–416
  displaying metadata, 414–416
  lesson review Q & A, 424–425
  modifying layout, 416–417
  overview of, 410–412
  publishing, 421–422
White balance
  adding adjustment to, 214–215
  adjusting with histogram, 231–233
  auto-correcting, 27–29
  correcting color clipping, 231
  resetting adjustments, 217–219
White points, 226, 255–256
Work environment setup, 461–465
Workflows, prebuilt, 469

X
X coordinates, Crop controls, 237

Y
Y coordinates, 237, 278
YouTube, sending slideshow to, 399–400

Z
Zoom
  changing to 50%, 114
  evaluating images in Full Screen view, 108–109
  in and out of image, 106–107
  pan and zoom technique. see Ken Burns theme

U
Underexposed images. see exposure
Unstack, 128–129
Update All Vaults button, 203–205
Update Previews, 105

W
Warning alert, 64–65, 105, 445
Watermarks, images with email, 38–39